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Getting Started with
Read Naturally SE

Read Naturally's pioneering programs offer a proven strategy to help struggling readers
improve their fluency and comprehension. This chapter provides an introduction to
Read Naturally Software Edition (SE), the software version of our reading strategy.

This chapter includes the following information:

®  An overview of the Read Naturally strategy on which our products are based.
m  Key features and benefits of Read Naturally SE.

®  Guidelines for identifying students who need fluency training.

®  An overview of the components of Read Naturally SE—Teacher Management,
Student Stories, and utility programs.

® A comparison of stand-alone and network installations of Read Naturally SE.
®m Instructions for starting and exiting Read Naturally SE.

m  Descriptions of the resources available if you need assistance using Read Naturally
SE.
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The Read Naturally Strategy

The Read Naturally strategy combines three research-proven strategies to develop

reading fluency.

The student reads along
while listening to a fluent
reader read the story the
student has selected.
Reading along helps
students learn unknown
words and encourages
proper pronunciation,
expression, and phrasing.

Teacher
Modeling

Progress
Monitoring

The student practices
reading a story until
abletoreaditata
predetermined goal
rate. Mastering the
story allows the student
to build fluency and
confidence.

Repeated
Reading

The student is given a challenging goal
and sees immediate feedback on progress
toward that goal, motivating him or her to
read and improve. After completing a
story, students can see before-and-after
feedback, making them aware of and
responsible for their own progress.

SE Teacher's Guide
Getting Started with Read Naturally SE
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Key Features and Benefits of Read Naturally SE

Students all over the country have made significant improvements in reading fluency
and in comprehension scores using the Read Naturally strategy. A number of case
studies provide evidence of these successes. If you would like more information about
the results of using the Read Naturally strategy, contact Read Naturally or visit our
website, www.readnaturally.com.

In addition to significantly improving fluency and comprehension, the Read Naturally
strategy positively impacts other areas of student development. Improvements include
the following:

®m  Increases self-esteem and confidence.
m  Gets students excited about reading.
®  Encourages students to take responsibility for their own successes.

m  Reduces behavior problems.

Advantages of the Software Edition

Read Naturally SE (Software Edition) provides the same powerful strategy and the same
high-interest stories as Read Naturally ME (Masters Edition) but is designed to take
advantage of the benefits and added functionality of computers. Some of the advantages
of Read Naturally SE include the following:

® A placement program that automates the process of determining what reading level
and goal is right for each student.

®  Guided steps with prompts that help students learn what to do next.

m  Professional recordings of the stories, synchronized with the story text during the
read-along step.

®  Vocabulary features, including spoken definitions of vocabulary words and the
ability to click difficult words to hear them spoken.

®  Automatic calculation of reading scores and automatic scoring of multiple-choice
questions.

m  Pictures, animations, and sounds that engage students.

m  Customization options, including the ability to skip steps for advanced students
and set the amount of time allowed for steps.

m  Extensive reports that automatically track students' progress and help you
determine when students need coaching or changes to their program.

Copyright © 2004—2009 Read Naturally, Inc. 3 SE Teacher's Guide
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Identifying Students Who Need Fluency Training

Students who read slowly and laboriously need to improve their fluency. A fluency
assessment tool, such as Read Naturally's Reading Fluency Benchmark Assessor, can
help you identify such students.

You can also use the information in the table below to draw conclusions and make
decisions about the oral reading fluency of your students. Students scoring significantly
below the 50th percentile using the average score from two unpracticed readings from
grade-level materials need a fluency-building program (such as Read Naturally SE or
ME).

Oral Reading Fluency Norms

Jan Hasbrouck and Gerald Tindal completed an extensive study of oral reading fluency
in 2004. The results of their study are published in a technical report entitled "Oral
Reading Fluency: 90 Years of Measurement," which is available on the University of
Oregon's website: brt.uoregon.edu/tech_reports.htm.

The table below shows the median oral reading fluency of students in grades 1 through
8 as determined by Hasbrouck and Tindal's data:

m Fall WCPM* | Winter WCPM* | Spring WCPM*
90 81

0 111
75 0 47 82
1 | 50 0 23 53 |
25 0 12 28
10 0 6 15
90 106 125 142
75 79 100 117
2 | 50 51 72 89
25 25 42 61
10 11 18 31
90 128 146 162
75 99 120 137
3 | 50 71 92 107
25 44 62 78
10 21 36 48
90 145 166 180
75 119 139 152
4 | 50 94 112 123
25 68 87 98
10 45 61 72
*WCPM = Words Correct Per Minute
SE Teacher's Guide 4 Copyright © 2004—2009 Read Naturally, Inc.
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m Fall WCPM* | Winter WCPM* | Spring WCPM*

166 182 194
75 139 156 168
5 | 50 110 127 139 |
25 85 99 109
10 61 74 83
90 177 195 204
75 153 167 177
6 | 50 127 140 150
25 98 111 122
10 68 82 93
90 180 192 202
75 156 165 177
7 | 50 128 136 150
25 102 109 123
10 79 88 98
90 185 199 199
75 161 173 177
8 | 50 133 146 151
25 106 115 124
10 77 84 97
*WCPM = Words Correct Per Minute
Components of Read Naturally SE
Read Naturally SE includes the following components:
Teacher Teachers use this component to manage student, teacher, and

Management

class information, specify student story options, place students

in the appropriate level, and print awards and letters. A powerful
reporting feature lets you track and analyze results for individual
students and groups of students.

Student Stories Students use this component when working with stories in their

purchased.

Copyright © 2004—2009 Read Naturally, Inc.
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reading levels. Student Stories automatically leads the students
through the steps of the Read Naturally strategy.

Database utilities make it easy for you to import data, back up
data, and check who is logged in. Customers with district server
licenses use the district administration utility to maintain the
district and school names and administrator passwords, manage
the licenses for SE levels, and generate a district usage
summary report. Customers with school server licenses use an
install license utility to add licenses for levels they have

SE Teacher's Guide
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Stand-Alone vs. Network Installation

You can run the software locally on individual computers (stand-alone installation) or
from a server in a local area network environment (network installation). The software
is available for both Windows and Macintosh operating systems.

Stand-Alone Installation

With a stand-alone installation, you run the SE applications from each computer's hard
drive. Student, teacher, and class data is stored locally on that computer. When students
read the stories, the CD containing the stories for their level must be in the computer's
CD drive. Since a student's data is stored on the computer where he or she reads the
stories, each student must always use the same computer in order to keep his or her
results in one place.

Network Installation

With a network installation, the stories, as well as student, teacher, and class data, are
stored on a shared central computer called a server. SE client software is installed on
workstations that have access to this district or school server. This setup makes it
possible for students, teachers, and administrators to work from any workstation that has
SE installed and can access the server.

SE Teacher's Guide 6 Copyright © 2004—2009 Read Naturally, Inc.
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Starting and Exiting Read Naturally SE

You can start either Teacher Management or Student Stories by double-clicking the
same Read Naturally SE icon. This icon is placed on the Windows or Macintosh
desktop when the software is installed and is also located in the Read Naturally SE
folder. The password you enter when you log in determines whether Teacher
Management or Student Stories starts.

To start Read Naturally SE: .
P
1 Double-click the Read Naturally icon on your desktop. h‘g\%
SE checks to see if there are any updates for the SE client software.

If updates are available on the server, SE automatically installs them.
Then the login screen displays.

Ele Rewtlopn HNework oo

Read Naturally
Software Edition G-

— 5 3

Northpoint Middle School

2 Type your password, and click Enter.

m [fyou enter a teacher or school administrator password, Teacher Management
starts.

m If you enter a student password, Student Stories starts.

Note: For stand-alone installations, you must insert the appropriate level CD in the
computer's CD drive before you log in as a student.

m  For stand-alone and school server installations, the first person who logs in after
SE is installed must enter the special password rnse to start Teacher
Management. This password is intended for one-time use only and no longer
works once an administrator password is set up.

Copyright © 2004—2009 Read Naturally, Inc. 7 SE Teacher's Guide
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To exit Read Naturally SE:

1 From either Teacher Management or Student Stories, click Quit (or choose Quit
from the File menu). This returns you to the login screen.

2 From the login screen, you can:
m  Click Exit to exit Read Naturally SE completely.
®  Log in to Teacher Management with a teacher or school administrator password.

m  Log in to Student Stories with a student password.

SE Teacher's Guide 8 Copyright © 2004—2009 Read Naturally, Inc.
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Getting Assistance When You Have Questions or Problems

If you have questions or problems while using Read Naturally SE, you have the
following options for getting assistance:

®  Check the manuals (SE Teacher's Guide, SE Sofiware Guide, and SE Answer
Guides).

®  Check the online help (Teacher Management and Student Stories).
m  Check the Read Naturally website.
m  Contact Read Naturally.

Check the Manuals

The manuals that ship with Read Naturally SE contain in-depth information for setting
up and using the software.

m  The SE Teacher's Guide is written from a teacher's perspective and includes
extensive information for setting up and using the software with students.

m  The SE Software Guide contains information about installing the software, setting it
up for the first time, and administering the information in SE.

m  The SE Answer Guides list the answers to the quiz questions. Teachers and their
assistants can use this guide to check students' answers.

The SE Teacher's Guide and the SE Software Guide include key word indexes to help
you find specific information quickly.

Check the Online Help

SE Teacher Management and Student Stories both include online help that you can
browse or search to find answers to your questions. Much of the information is similar
to the topics in the SE Teacher's Guide and the SE Software Guide.

To view the online help in either Teacher Management or Student Stories, select Read
Naturally Help from the Help menu. The help opens in a separate window. From this
window, you can locate information using the Contents and Search tabs.

(o EHICHETN Allows you to locate help topics by browsing through a list of the
topics available. This option is equivalent to a book's table of
contents.

Search Tab Provides full-text search capabilities. To search, enter a word or
phrase and then either click the Find button or press the Enter key.
The search locates all occurrences of the word or phrase throughout
the help system and displays a list of help topics found.

Copyright © 2004—2009 Read Naturally, Inc. 9 SE Teacher's Guide
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Check the Read Naturally Website

If you have problems using Read Naturally SE, check the support section of the Read
Naturally website:

www.readnaturally.com/support/

The support pages include frequently asked questions, knowledgebases, troubleshooting
information, updates to the software, electronic files of the manuals, and more.

Other pages on the website contain background information about the Read Naturally
strategy, case studies illustrating the effectiveness of the strategy, and information about
Read Naturally products and seminars.

Contact Read Naturally

You can contact Read Naturally with questions, problems, or to order additional
products.

Online Software www.readnaturally.com/support/supportRequest.htm
Support Request

Telephone 651.452.4085 or 800.788.4085

651.452.9204

E-mail Address info@readnaturally.com
for General Issues

www.readnaturally.com

Office Hours Monday through Friday
9:00 a.m. to 5:00 p.m. Central Time

SE Teacher's Guide 10 Copyright © 2004—2009 Read Naturally, Inc.
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E Using Teacher Management

The Teacher Management component opens when you log in to Read Naturally SE with
a teacher or administrator password. You use Teacher Management to set up and
maintain the following information:

m  School information—the school name, district name or number, and administrator
password.

m  Teacher information—the names and passwords of the teachers and teacher
assistants who use Read Naturally SE.

m  (Class information—the names of the classes and the teachers assigned to them.
®m  Student information, including:

— Identification and profile information, such as the student's name, 1D, password,
grade, class, teacher, and characteristics.

— Story options, including their goal, level, and SE step options.
You can also perform the following tasks from Teacher Management:
m  Reset stories if a student has difficulty passing a story.

m  Place students in the appropriate level and goal by testing them with sample stories.
(For information on placing students, see Chapter 3.)

®  Print awards and parent letters for students.
m  Print the stories in a level.

m  Generate reports to analyze data for the school, classes, teachers, or individual
students. (For information on reports, see Chapter 7.)

Logging In to Teacher Management

You can log in to either Teacher Management or Student Stories from the same
login screen. When you log in with a teacher or school administrator password, Teacher
Management starts.

Copyright © 2004—2009 Read Naturally, Inc. 11 SE Teacher's Guide
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Changing Your Teacher Information

Teachers can change their own name and password. The school administrator can add
teachers, delete teachers, and change any of the teachers' names and passwords (see the
SE Sofiware Guide for more information).

To change your teacher information:

1 Log in with your teacher password.

2 Select the Teachers tab.

3 Change your name or password as necessary.
4

Click Save.

Searching the Class and Student Lists

Teacher Management has sort and search features to help you find students and classes.
The administrator can also sort and search the teacher list.

To sort a list Click a column heading to sort by that column.

To search a list Click the heading of the column you want to search.

In the Find box at the bottom of the window, type the text
you want to search for.

Click Find. The list shows the items that match your search.

Click Show All to see the complete list again.

SE Teacher's Guide 12 Copyright © 2004—2009 Read Naturally, Inc.
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Maintaining Class Information

Teachers can add, rename, and delete only those classes that are assigned to them. The
administrator can add, change, and delete any of the classes.

To maintain class information:

1 Log in with your teacher password.
2 Choose the Classes tab.

3 Perform any of the following actions:

Add a class a Click Add.
Specify a class name.

Administrators must select a teacher from the drop-down
list to assign the class to him or her. When teachers add
classes, the classes are automatically assigned to them.

Click Add to add another class, or click Save to return to
the class list.

Choose the class you want to change.
Click Edit.

Edit the class as necessary. Teachers can only change
the name of the class. Administrators can also change
the teacher assigned to the class.

Click Save.

Delete a class Choose the class you want to delete. You cannot delete
classes with students assigned to them.

Click Delete.
Click Yes to confirm.
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Maintaining Student Information

If you log in as a teacher, you can add, change, and delete only those students that are
assigned to you. If you log in as an administrator, you can add, change, and delete
students assigned to any of the teachers.

You can enter an unlimited number of students into the Teacher Management System.

To maintain student information:
1 Log in with your teacher password.

2 Choose the Students tab.

3 Perform any of the following actions.

Add a student a Click Add.

b Complete the following required information (blue
headings):

m First Name/Last Name
B  Grade

B Password: This is what the student will enter when
logging in. It must be 3 to 14 characters long.

B Teacher: If you log in as a teacher, no selection is
necessary, since all of the students you add are
assigned to you.

B Class: Choose the class to which the student
belongs. Only the classes assigned to the current
teacher are available.

You can also provide the following optional information:
m  Student ID
B Characteristics (gender and type of student)

Click Add to add another student or click Save to return
to the student list.

Click Yes to set up the student's story options right away
(see Chapter 3), or click No to set them up later.

Edit a student's Either double-click the name of a student, or choose a
identification student and then click Edit.
information Change the student information as necessary.

Click Save.

Delete a student Choose the student you want to delete.
Click Delete.
Click Yes to confirm.

SE Teacher's Guide 14 Copyright © 2004—2009 Read Naturally, Inc.
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Reassign Select the students you want to reassign.

students m To select a group of students that are listed together,
click the first student, hold down the Shift key, and
then click the last student.

m  To select multiple students that are not listed
together, hold down the Control key (Windows) or
the Command key (Macintosh) and then click the
students you want to reassign.

Click Reassign.

Specify the new class and grade to which you want the
student assigned. Administrators can also reassign
students to another school (district licenses only) and
teacher.

Click Save.
Click Yes to confirm the changes.

Resetting Stories for a Student

If a student is struggling with a story and cannot pass it, you can reset the story and allow
the student to try it again later.

Note: Only teachers and the administrator can reset stories. Teacher assistants cannot reset
stories.

To reset stories for a student:

1 Access student options in either of the following ways:

B [og in with a teacher password to start Teacher Management. From the Student tab,
choose a student, and then click Story Options.

B From Student Stories, choose Story Options from the Edit menu. Then enter your
teacher password, and click OK.

2 Choose the Advanced tab.
3 Choose the story you want to reset, and click Reset.
4 Click Yes to confirm.
5 Click Save.
Copyright © 2004—2009 Read Naturally, Inc. 15 SE Teacher's Guide
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Printing Awards and Letters

Read Naturally SE provides the following documents for communicating with parents:

® A letter introducing the Read Naturally program that you can give to parents when
their children begin working with the program.

m A periodic report that tells parents about the progress that their children have made
in the Read Naturally program (see Chapter 7 for more information).

® A Super Reader award you can send home to parents when their child completes
12 stories in a level.

You can use awards to keep parents involved in the learning process. After a student
passes 12 stories in a level, you may want to staple printed copies of the stories together,
attach the award as a cover letter, and ask the student to take the booklet of stories home
to read and discuss with his or her parents. Parents can then sign the award, and the
student can return the bottom portion to you.

To print a parent letter:

1 Log in with your teacher password.
From the Students tab, choose a student, and click Letters.

2
3 Choose Parent Letter, and click OK. The parent letter opens in a separate window.
4 To print the letter, choose Print from the File menu.

5

Be sure to sign the letters before sending them home with students.

To print a Super Reader award:

1 Log in with your teacher password.

2 From the Students tab, choose a student and click Letters.
3 Choose Super Reader Award, and click OK.
4

Choose the level for which the student has completed 12 stories, and then click OK.
The Super Reader Award opens in a separate window with the student's name, the
level, and the goal rate he or she achieved.

5 To print the award, choose Print from the File menu.
6 Sign the award, and add comments to personalize it for the student.

7 Send the award home with the student, and include copies of the stories he or she
completed. For information about printing the stories, see "Printing the Stories in a
Level" on the next page.
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Printing the Stories in a Level

From Teacher Management, you can print one or more of the stories in a level,
including the quiz questions, regardless of which levels and stories students are
working in.

To print the stories in a level:
1 Log in with your teacher password.
2 From the File menu, choose Print Stories.
3 Select the level for which you want to print stories. Only licensed levels are shown.
4 Select the stories you want to print.
To select one story, click the story name.

To select all of the stories in a level, click Select All.

To select a group of stories that are listed together, click the first story, hold
down the Shift key, and then click the last story.

m  To select multiple stories that are not listed together, hold down the Control key
(Windows) or # key (Macintosh) and then click the stories you want to print.
5 Click OK. The selected stories open in your default web browser.

6 To print the stories, choose Print from the File menu.
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ﬂ Working With Students

This chapter includes the following information:

® A summary of teachers' responsibilities for setting up and using Read Naturally SE
with their students.

®  Guidelines for setting up your workspace for Read Naturally SE.

®  Explanations of the concepts of instructional level and reading rate goal.
m Instructions for placing students in an appropriate level and goal.

m Instructions for setting up story options for students.

® A lesson plan for introducing Read Naturally SE to your students.

®  Guidelines for monitoring students and determining when to adjust their levels or
goals.

Use the information in this chapter as a guideline. You need to use your knowledge of
your students in conjunction with these guidelines to determine the correct level of
material and to set developmentally appropriate goals for them.
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SE Teacher Responsiblities

Teachers have the following responsibilities for setting up and using Read Naturally SE
with their students:

1

Set up your schedule and workspace, gather the materials you will need, and set up
the computers (see below).

Place the students to determine the appropriate goal and level of material (see
"Placing Students" in this chapter).

Set the story options for the students in Teacher Management (see "Setting Up Story
Options for Students" in this chapter).

Teach behaviors, such as logging on to Student Stories and following the steps (see
"Lesson Plan to Introduce Read Naturally SE" in this chapter).

Monitor the students' progress by timing them every two weeks to make sure the
goal rate and reading level of material are correct (see "Adjusting Levels and Goals
for Students."

Communicate with students and parents. Periodically, take time to recognize
students' progress and to let parents know how their children are doing. (See
"Printing Letters and Awards" in Chapter 2.)

Setting Up Your Workspace

You can use Read Naturally SE in a variety of settings, depending upon where
computers are available, such as a classroom, media center, or computer lab.

You need to set up your workspace differently depending on whether you install the
applications on individual computers (stand-alone setup) or on a server (network setup).
With either option, it is helpful to hang a Read Naturally SE poster in the room and to
make SE Answer Guides available in a central location.

Materials You Will Need
To use Read Naturally SE, you need the items listed below:

m  Computer workstation(s)
m  Headphones
m  Appropriate level CD for each student (stand-alone installations only)
m  SE Answer Guides for checking the students' answers to the quiz questions
m  Read Naturally SE poster (optional)
m  Student folders for copies of the stories, awards, results, etc. (optional)
SE Teacher's Guide 20 Copyright © 2004—2009 Read Naturally, Inc.

Working with Students Read Naturally Software Edition



Read Naturally sells headphones, additional SE Answer Guides (one copy is
complimentary), folders, and posters. For more information, contact Read Naturally
or visit the Read Naturally website at www.readnaturally.com.

Stand-Alone Setup

For stand-alone installations of Read Naturally SE, you need to make the CDs for the
appropriate levels available to each student. If you have multiple students working in
the same level, you may want to purchase enough CD albums to divide the CDs
according to level. You can also group the CDs within an album by color (they are
color-coded by level). We recommend labeling the spine of the CD albums to indicate
which level(s) are included.

In a stand-alone setup, each student should use Student Stories on the same computer
every time to keep all of his or her results in one place.

Network Setup

For network installations of Read Naturally SE, the student does not need access to
the CDs. The stories and student results are stored on a school or district server. As
a result, students can use Student Stories from any computer that is connected to the
network and set up with the SE client software.

Make sure that the SE icon is on the desktop of the computers where students will use
Student Stories.

Poster

You can hang a Read Naturally SE poster on the wall near the computers where the
students will work. The poster helps the students understand the process and provides
them with helpful tips for using Student Stories.

SE Answer Guides

You should make SE Answer Guides available in a central location where each
individual who will pass students (for example, teaching assistants and volunteers)
can locate one. The SE Answer Guides include the answers to the questions in the
quiz step. The computer automatically corrects the multiple-choice questions, but
you need to correct the open-ended questions during the Pass step. If you need
additional SE Answer Guides, you can order extra copies from Read Naturally.
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Levels and Goals

When you place students, you establish both an instructional level and a reading rate
goal that are appropriate for each student. You also select the type of curriculum that
best meets the needs of each student. Correctly placing a student is crucial to the
student's success in Read Naturally. The combination of instructional level and goal rate
should challenge the student without being frustrating.

Levels

Reading levels indicate the degree of difficulty. Read Naturally assigns levels to its
materials, from first to eighth grade reading level, based on the following readability
formulas:

®  Fry and Spache readability formulas for levels .8 through 2.7.
m  Harris-Jacobson readability formula for levels 3.0 through 5.0.
®  Dale Chall readability formula for levels 5.6 and above.

When a student begins Read Naturally, use the placement program to place the student
in the initial level. The level of reading material needs to be sufficiently difficult to
challenge the student with new words and/or more complex sentences. The level of
material needs to be easy enough that the student can pass a story after reading along
and then practicing the story five to ten times.

As the student continues to work with the program, adjust the difficulty of the reading
material to meet the changing needs of the student. For more information, see
"Adjusting Levels" in this chapter.

Types of Curriculum

The following levels and types of curriculum are available for Read Naturally SE:

Sequenced American Manners Spanish
g & Customs, Idioms Series
1.0 4.5 3.0 10

. . .8 . .
15 5.0 1.3 3.5 11
2.0 5.6 1.8 4.0 2.0
2.5 6.0 2.3 4.5 2.5
3.0 7.0 2.6 3.5
3.5 8.0 2.7 4.5
4.0

The Sequenced Series is the basic curriculum and is appropriate for any developing or
struggling reader. The sequenced levels build fluency and support comprehension and
vocabulary growth.
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The Phonics Series is primarily designed to build fluency. But the Phonics Series also
includes features that focus on decoding specific phonics patterns. Each story includes
words with the featured pattern, a short audio phonics lesson, and a word list activity.

The American Manners and Customs Series is designed to acquaint English language
learners with some American manners and customs as they work on reading fluency and
comprehension. The stories include extra audio and vocabulary support.

With the Idioms Series, both native speakers and English language learners can learn
common American idioms as they work on reading fluency. The stories include extra
audio and vocabulary support.

The stories in the Spanish Series are translations of the corresponding stories in the
English-language Sequenced Series. Spanish-speaking students can work through a
level in Spanish before working through the same level in English.

Goals

The reading rate goal is the number of words a student must read correctly per minute in
order to pass a story. For each student, you set a predetermined goal that is appropriate
for his or her current reading ability. The goal needs to be sufficiently high to require
the student to practice reading the story many times in order to achieve the goal rate, but
not so high that the student becomes frustrated.

After you have set the initial goal for students, they usually keep that goal for at least
six stories, typically about two weeks. You can adjust the goal as the students' reading
fluency improves. For more information, see "Adjusting Goals" in this chapter.

Placing Students

Read Naturally SE includes a placement program that automates the process of
determining what level and goal are appropriate for a student. The placement program's
recommendations are guidelines. Select the goals and levels best suited for students.

The table on the right shows the guidelines the Scores in This
placement program uses to determine which Placement Range Indicate a
level is appropriate. To determine the goal, the Potential Fit
placement program adds 40 to the student's 10to0 3.0 30 — 60 wepm
score for grades 5 and above and 30 to the

Testing Level

score for grades below 5. The goal is then 3.5105.0 60 — 80 wepm
rounded up or down to the nearest 5 to make it 5.61t07.0 80 — 100 wepm
easier for students to work with their goals. 8.0 100 — 140 wepm
Beginning readers can start in Read Naturally wcpm = words correct per minute

level .8 or 1.0 when they know beginning
sounds and can recognize approximately 50 words. The initial goal is typically around
50 wepm in level .8 and about 60—70 wepm in level 1.0.
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To place students using the SE placement program:

1

2
3
4

Log in with your teacher password. (Teacher assistants cannot place students.)
Choose the Students tab.
Select the student you want to place, and then click Place.

Estimate the level at which the student is currently reading. You can base this
estimate on test results, your own knowledge and experience, or a formal
assessment tool, such as Read Naturally's Reading Fluency Benchmark Assessor.
Select the placement testing level, and click Next.

If you have not purchased SE curriculum at the instructional level you selected, a
warning is displayed. Click Yes to continue testing the student with the level you
selected, or click No to select another level. A story at the level you selected opens.

If desired, click the Reading Guide icon to turn the reading guide on or off. The
reading guide can help the student follow along.

When the student is ready to start reading, have him or her click Start.

As the student reads aloud, listen and silently count the number of errors he or
she makes. (See the description of the Pass step in Chapter 5 for guidelines for
counting errors.)

When the bell sounds, click the last word the student read.
Enter the number of words the student missed, and then click Next.

The placement program analyzes the results and either recommends a level and goal
or recommends that you test the student at a higher or lower level.

10 Depending upon the situation, take one of the following actions:

RGN ELLT G il eI e[ 118 Choose Select Level/Curriculum and Goal,
(L I EHGEREREVEIRELG I select a curriculum for the student, and then
goal... click Next. Curriculum you have not licensed is
dimmed.

B GENECETNER NI L[l Choose Continue Testing and click Next to test
(I EHGERCE RGN the student with another story, and then repeat
ST I T M-I the process.

Continue to test the student at additional levels
until the placement program recommends a
level and goal.

If you think you have Choose Manually Set Level and Goal and
enough information to click Next.

place the student on Enter the level and goal in the story options.

your own without a ;
recommendation... Click Save.
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Setting Up Story Options for Students

In the story options, you customize the Read Naturally process for each student.
You set each student's level and goal, specify which steps are included, and tailor
the behavior of the program to suit each individual student.

You can access story options from either Teacher Management or Student Stories.

From Teacher Management, teachers can set up or change the options for all of their
students. From Student Stories, teachers can only change the options for the student
that is currently logged in. Teacher assistants cannot set up or change story options.

To set up story options from Teacher Management:

1 Access story options in either of the following ways:

®  Log in with a teacher password to start Teacher Management. From the
Students tab, choose a student and then click Story Options.

®  From Student Stories, choose Story Options from the Edit menu. Then enter
your teacher password, and click OK.

3 Change the story options as necessary. Click the Advanced tab for more options.
The options are described in the tables below.

4 Click Save.

Basic Tab: Placement

Specify the reading rate, in words correct per minute, that you are
setting as the student's goal.

Select the student's instructional level as determined by placement
tests or previous Read Naturally results. Only the levels installed
on your system are listed.

Select which set of stories you want available for students:
m  Set 1: Only the first 12 stories in the level are available.
m  Set 2: Only the second 12 stories in the level are available.

B Auto: When the student starts the level, the first 12 stories are
available. When the student finishes all 12 stories, the second
12 stories automatically become available.

If you choose Set 1 or Set 2, when the student finishes all 12
stories in the set, the teacher must manually change to the other
set to make the other 12 stories available. This gives the teacher
a chance to check a student's progress before he or she continues
with the rest of the stories. For instance, the teacher might decide
to raise the student's level rather than have him or her read the
rest of the stories in the current level.
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Basic Tab: SE Steps

The steps that are checked are included as a student works through a story. This lets
you customize the process for each student.

Key Words

Cold Timing

Read Along

Check this box to include the Key Words step.

Check this box to include the Prediction step. You can also
change the length of time allowed for writing the prediction.

Check this box to include the Cold Timing step.

Check this box to include the Read Along step. You can further
customize the Read Along step with these options:

B Vocabulary: Check this box to to let students click vocabulary
words to see and hear their definitions.

B Required Listening: Specify how many times the student is
required to read along (up to 7). The default is 3.

B Speeds: Specify the reading speed for each of the read
alongs. For three read alongs, the recommended settings
are normal for the first one, 7.5% increase for the second
one, and 15% increase for the third one.

Check this box to include the Quiz step. If you check the Open-
ended questions box, all of the questions are included. If this box
is not checked, open-ended questions (typically questions 5, 8, and
9) are not included.

Check this box to include the Retell step. You can also change the
length of time allowed for writing the retell.

Students may be able to skip the Retell step when they can read
material half a year to a year above their grade level with very few
errors and with fluency approaching grade-level expectations on
cold readings.

Basic Tab: Phonics Options

The following option is available only if a phonics level is selected.

Word List

SE Teacher's Guide
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Check this box to include the Practice Word List and Pass Word
List steps. See Chapter 6 for more information.
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Advanced Tab

Practice/Pass
Timings

Cold Timing

Word List

Timings

Reset Stories

Enable
Instructional
Audio

Reset all
options to
EETS
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Select how you want to time the student in the practice and pass

timing steps:

B 1-minute: Students read for one minute, after which a bell
sounds, and they click the last word they read.

B 2-minute: Students read for two minutes, after which a bell
sounds, and they click the last word they read.

®  Whole story timing: Students read the whole story and click
the Finished button when they are done.

Check student to allow students to start cold timing on their own.

Check teacher required to require a teacher to enter a password
before cold timing can begin. This option lets you observe the cold
timing to make sure it is accurate.

Phonics levels only: Select either 45 seconds or 1 minute as the
length of time allowed for the word list timings. Forty-five seconds
may be enough time for lower levels with shorter word lists.

If a student is struggling with a story and cannot pass it, you can
reset the story and allow the student to try it again later. To reset a
story:

1 Choose the story you want to reset.

2 Click Reset.
Check this box if you want students to hear audio instructions that
tell them what they need to do as they work through the steps.

Once a student is familiar with the process, you may be able to
turn off the audio instructions.

Click this button to return all of the options to their original settings.
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Lesson Plan to Introduce Read Naturally SE

Before asking students to begin working independently, you may want to demonstrate
Student Stories and walk through the steps of the process together. To demonstrate, you
can work through one or two stories together.

Setting Up the Lesson

For the purpose of the demonstration, you can set yourself up as a student and set your
story options to an appropriate level, goal, etc. You can delete yourself as a student
after the demonstration. For more information, see "Maintaining Student Information"
in Chapter 2.

First Demonstration

Opening Student Stories
1 Show the students how to open Read Naturally SE. Make sure they see what the
icon looks like and how to double-click it to open the login screen.

2 Show the students how to enter a password and click the Enter button. Explain that
they will each have their own password.

Select a Story Step
1 Select a story to read.

2 Explain as you demonstrate that they must click the story, and then verify that
Student Stories opened the correct story.

Key Words Step
1 Tell the students to read along as the key words are spoken.

2 Tell the students they should click the key words they don't know to see and hear
their definitions.

Prediction Step

1 Look at the title, key words, and picture. Discuss what the story might say about
the topic.

2 Point out that they can click the Back button to return to the Key Words step if they
want to review the key words and what they mean.

3 Show the students how to type their thoughts into the text box. Use this opportunity
to teach how the text boxes work.

4 Click the Next button to continue to the Cold Timing step. Explain that they will
often need to click Next to go to the next screen, and that the software will not let
them click Next until they complete what they need to do on the current screen.
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Cold Timing Step

1
2

Explain that Student Stories will time them as they read the story.

Explain what the reading guide will do, and show how to turn it on and off using the
reading guide button.

Point out the speaker/question mark button in the upper left-hand corner, and
demonstrate how it repeats the audio instructions. Explain that the icon is available
throughout the process.

Click the Start button, explaining to the students that they will click this Start
button when they are ready to begin reading. Instruct them to read the story aloud,
but quietly. At this point, you may want to point out the reading guide again. If
you turned it on, they can see what it looks like.

Tell the students that as they read they should click on the words they are unsure of.
Click on a word to demonstrate how the unknown words change color.

If you demonstrate with level 5.6 or above, show the students how to advance to the
second page of the story by clicking the More button.

Wait for the bell to sound, and then show the students how to click on the last word
they read. Click the Next button to display the cold timing graph.

Point out that the cold timing graph fills in blue to the number of words read
correctly per minute. Point out that their goal is on the graph. Click the Next
button to continue to the Read Along step.

Read Along Step

1

Explain to the students that they will read along with the story three times (or
however many times you determine). Teach students that they can't just listen
to the narrator but must quietly read aloud.

Click the Start button to begin the first reading. Point out that the sentence displays
in blue as the narrator reads it.

Show the students that they can tell how many more times to read along by holding
the cursor over the Read Along tab. At the end of the first read along, point out that
there are two read alongs left (assuming they were set up for three read alongs).

Begin another read along, and show the students that they can stop if necessary by
clicking on the Stop button above the story. Point out that the number of read
alongs left did not change, because you did not complete the read along.

After completing all the required read alongs, tell the students that they can read
along again if they think it's necessary. Otherwise, they can click the Next button to
continue to the Practice step.
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Practice Step

1 Explain to the students that they will practice the story until they can read it at their
goal rate. You can tell each student his or her goal or tell all the students that you
will inform them of their goals later.

2 Show the students how to click the Start button to begin practicing. You should
practice without reaching the goal the first couple of times.

3 Show the students that the practice scores display at the bottom of the screen so
they can tell when they are getting closer to the goal. You may want to turn off
the reading guide for one of the practice readings so the students can see what it
looks like when the reading guide is off.

4 Show students they can click on a word to hear it pronounced.

5 If you demonstrate with level 5.6 or above, show the students how to advance to the
second page of the story by clicking the More button at the bottom of the screen. If
you demonstrate with level 5.0 or below, click the Finished button before the timer
sounds to show the students that they can use this button if they finish reading the
story before the bell sounds. When you reach the goal, click the Next button to
continue to the Questions step.

Exiting Before Finishing a Story

1 Click the Quit button to exit the program, and explain to the students that they can
exit the program at any point if the class period ends while they are in the middle of
a story.

2 Log in again with the same student password. Point out that Student Stories brings
them back to the point where they left off in the story.

Questions Step

1 Answer the questions, making sure the students understand the mechanics of
answering each type of question (e.g., click the letter for multiple choice, click the
word that belongs in the highlighted line for fill in the blank, type in the text box for
open-ended questions). The question format depends on the level.

2 Answer one of the multiple-choice questions incorrectly to demonstrate how Student
Stories asks the students to re-answer the questions that they answered incorrectly.
Explain that they cannot pass until they answer all the questions correctly.
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Retell Step
1 Tell the students that after they answer the questions, they will retell the story.
2 Discuss what the story was about.

3 Show the students how to click the Review Story button to see the story one last
time. Explain that they can return to the story only once before completing the
retell. After closing the story, point out that the Review Story button is no longer
available.

4 Type aretell. If you will have requirements for the retell (e.g., at least three ideas),
explain them to the students. Click the Next button to continue to the Pass step.

Pass Step

1 Point out that a red "Ready to Pass" box displays at the top of the screen to alert you
that it's time to pass the story. Tell the students that they should continue practicing
while they wait for you to come over to them.

2 Begin a practice timing. Stop the practice timing by clicking the Stop button above
the story to show that, when the teacher comes, they can stop their current timing
and move on to the Pass step.

3 Click the Pass button, and enter your teacher password. You may want to click this
button and enter your password without commenting about what you are doing. If
you provide too much information, you may increase the students' interest in trying
to pass themselves.

4 Tell the students that, for the pass timings, you will click the Start button when you
hear them begin to read. For whole-story timings, click the Finished button when
the student finishes the story. For one- or two-minute timings, wait for the bell to
sound, and then click on the last word the student read. Then enter the number of
errors and the expression rating, and correct the open-ended question(s). You may
want to fail one of the criteria needed to pass to show the students what will happen
if they don't pass the first time. For more information, see the description of the
Pass step in Chapter 5.

5 Once you pass all of the criteria, the final timing graph displays. Point out that the
graph displays the number of words read correctly and fills in the space between the
cold timing number and the passing number in red.

6 Click the Graph Stories button. Show the students that the stories they passed in
the level will all display on the graph so they can see their progress from story to
story. (Before the demonstration, you may want to pass a different story in the level
so that the graph displays more than one story.)

7  Click the New Story button to show the students that after passing a story, they
begin the process again.
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Second Demonstration

If you have the resources, running through the steps a second time with each of the
students at their computers may further increase their understanding of the program.

If you do a hands-on demonstration, you need to set up each student's story options

for the level they will use during the demonstration. Once you finish, delete each

story used during the demonstration so those stories do not show up in your official
report results. For more information, see "Resetting Stories for a Student" in Chapter 2.

Adjusting Levels and Goals for Students

It is essential that students using Read Naturally work in the level of material that
both challenges them and allows them to succeed. Consequently, teachers need to
continuously observe each student in order to know when to change reading levels
and goals.

You and the student should discuss the situation whenever you adjust goals or reading
levels. Students need to become aware of their successes and challenges so they know
what needs their attention.

When to Adjust a Student's Goal or Level

You should assess students every two weeks and after students complete 12 stories in a
level to determine if the goal rate or reading level of material is still appropriate. You
and the student should decide whether he or she should continue in the same level with
the same goal, adjust the reading rate goal, or move to more difficult reading material.

Occasionally, you will need to adjust a reading level or goal within a few days of
beginning the program because of an incorrect initial placement. Usually, however,
students work in their initial level and with their initial goal for at least two weeks and
sometimes for several weeks before you need to adjust their levels and goals.

You need to consider raising goal rates or reading levels when one or more of the
following conditions apply to the student:

B The student's cold reading rates constantly increase.

B The student only needs to read along once or twice.
B The student only needs to practice a story without the recording a few times.
B The student consistently surpasses his or her goal.
B The student begins to show signs of boredom.
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Raising Goals vs. Raising Levels

You must decide whether to raise a goal or level based on each individual situation.
When deciding, keep in mind the following:

B Raise goals more often than levels.

B Raise only one element (level or goal) at a time.

B Usually wait until the student has completed 24 stories in a level to raise the level.
[

Sometimes when students have made rapid progress, they do need to change levels
after reading less than 24 stories, sometimes 12 or less.

B Don't lose sight of the long-term fluency goals.

Raising the Goal

You should raise a student's goal as the student's reading fluency improves. Raise the
goal if a student passes stories after only a few practice readings or if a student
consistently exceeds the goal. You can change the goal at any time, but do not increase
it at the same time you raise the level of reading material. Usually, you raise a goal by
10 words correct per minute at a time.

Raising the Level of Material

As a student continues to work with the program, adjust the level of the reading material
to meet the student's changing needs. The student usually finishes all 24 stories in a
level before advancing to the next level. The goal usually remains the same when you
raise the level.

If the student begins to pass the stories without practicing several times, consider raising
the goal instead of raising the level of material.

Occasionally, a student improves significantly before passing all 24 stories in a level.
Evidence of this is the student's ability to read unpracticed stories well after reading
along with the recording only once or not at all. If a student makes rapid progress, raise
the difficulty level of material even if he or she has not read all 24 stories in the level—
for example, after completing the first 12 stories in the level.

Decreasing the Goal or Level

Occasionally, you may need to decrease a goal or a reading level. Usually, you will
make such adjustments in the first week or two of the program if the initial level and/or
goal are incorrect.

Later, you may need to decrease the goal or level if a student cannot pass stories after
several practice readings, shows signs of frustration, or consistently makes a high
number of errors during the pass timing.
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Students sometimes make too many errors because they are focused on trying to read
faster. If simply drawing attention to the increased error rate does not solve the
problem, you may need to temporarily lower the goal and attend to accuracy.

Adjusting the Steps

The read along step is crucial for teaching correct pronunciation, phrasing, and
expression. However, middle and high school students may be ready to drop the read
along step when they can read grade-level material with very few errors at a fluency
approaching grade-level expectations. If an older student regularly has cold timing
scores above 90 words correct per minute with few errors and few phrasing and
expression problems, have the student go directly to the practice step after the cold
timing step. Rather than drop the read along step all at once, you could also gradually
reduce the number of read alongs from three to two to one and finally to none.

The writing steps—prediction and retell—promote comprehension and have proven to
be beneficial for many students. However, if a student is very deficient in fluency and
you have a limited amount of time, you might consider making the following changes to
these steps:

B Drop the prediction step. The student would still use the key words, title, and
picture to mentally prepare for reading the story.

B Have students retell the story orally instead of in writing at the time of the final pass
step.

Teachers may also consider these changes for students who very slow at keyboarding.
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n Using Student Stories

Student Stories opens when you log in to Read Naturally SE with a student password.
Student Stories automatically leads students through the Read Naturally steps as they
work with the stories in their reading levels.

We recommend that students use Read Naturally a minimum of three times a week,
although four or five times a week is even better. Ideally, each Read Naturally session
should be at least 30 minutes long, although 45 minutes is better.

This chapter includes the following information:

m  Descriptions of the common features of the Student Stories screens.

m  Descriptions of the Student Stories menu options.

m  Descriptions of the Scores summary available from the Student Stories screens.

®  Procedures for changing students' story options, changing Student Stories
preferences, and printing stories and students' results.

See Chapter 5 for in-depth instructions for the steps that students follow when working
with stories in Student Stories.

Logging In to Student Stories
You can log in to either Teacher Management or Student Stories from the same login
screen. When you log in with a student password, Student Stories starts.

For stand-alone installations, the level CD must be in the computer's CD drive before
you log in to Student Stories.
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Common Features of the Student Stories Screens

The following diagram shows some of the common features of the Student Stories
screens. The Windows version of the screen is shown below. In the Macintosh version,
the title bar and menu bar will appear differently.

Audio Instructions Start/Stop Icon: Click
Icon: Click this to hear this to start and stop
the audio instructions timing. If you stop and
repeated. restart, timing starts over. Progress Bar: Shows all of
the steps and highlights the
Title Bar: Shows the story current step in blue.

titte and reading level.

Scores: Click this to view
a summary of the student's
options and progress so
far. See page 38 for more
information.

Menu Bar: See the next
page for descriptions of
the menu options. On
Macs, the menu bar is
at the top of the screen.

® Hippos - Level 3.5

File Edit Retest Help
Key Words | Prediction | Cold Timj#g | Read Along | | Quiz | Retell | Ready\p Pass
Reading N P o Scores
Guide - %7 3
M Start
Icon: //
Click this N -
Many people think a hippopotamus would eat a person ifit had the
to turn the opportunity. But hippos are plant eaters; they do not eat people. Still, they
. are mean and fast, 5o it1s bestto stay far away from them.
Readmg Hippos spend maost of the day in shallow African rivers. They like to
i walk on the bottom of rivers, hutthey are not looking for food. They are
uide o
trving to stay cool. Hippos are excellent swimmers. They can hald their
and on. | breath for five or six rinutes while subrmerged in the water, |
" Hippos are nocturnal. At nightthey move to land to eat grass and
plants. They eatfar five ar six hours a night. They can eat 130 pounds of Practice #1: 80
Readi food at a single meal. Eating large meals allows hippos to live for weeks Practice #2: 91
eading without eating anything ifthey must. They live in large mud pits and stay as
Guide: still a5 possible to conserve energy.
. . Hippos have enormous mauths with huge teeth. Their lips are two
nghllg hts feetwide, and each tooth weighs about six pounds. Most hippos weigh
eaCh “ne farr?;”;dmiﬁg?g pounds. Onlythe elephant and the rhinoceros are larger
to help the
students'
eyes track
correctly /@
across the
line.
Quit Button: Click this to Back Button: Click Next Button: Click
exit the story and return this to review the this to advance to
to the login screen. previous step. the next step.
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Student Stories Menu Options

The Student Stories menus include the following options:

File Menu

W Prints the Congratulations screen at the end of a story.
m Prints the story elements and student results you select.
m Closes Student Stories and returns you to the login screen.

Edit Menu

ST Ne i M | ets you change the story options for the current student (requires
a teacher password). See "Setting Up Story Options for Students"
in Chapter 3 for more information.

Retest Menu
Cold Timing Discards the student's previous Cold Timing score and lets the
student repeat the Cold Timing step.

Pass Timing Discards the student's previous Pass Timing score and lets the
student repeat the Pass Timing step.
Word List Discards the student's previous Pass Word List score and lets the

student repeat the Pass Word List step. This option is available
only for phonics levels.

Help Menu

FEELRVELITENWA Displays help information that explains how to use Student Stories.
Help See "Getting Assistance When You Have Questions or Problems"
in Chapter 1 for more information.

About Read Displays the SE version number and contact information for Read
Naturally Naturally.
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Scores Summary

Starting with the Read Along step in Student Stories, students or teachers can click
Scores in the upper right corner (see "Common Features of the Student Stories Screens"
in this chapter) to display a quick summary of the student's settings and his or her
results for the current story up to that point. Depending on which step the student is
currently working on, the Scores summary can display some or all of the following
information:

Level The reading level currently assigned to this student in the story
options.

Which set of stories in the level is currently available to the
student—1 (for the first 12 stories) or 2 (for the second 12
stories).

The reading rate, in words correct per minute, that is currently
set as the student's goal.

Cold Timing The number of words correct per minute that the student read
during the Cold Timing step.

Difficult Words The unknown or difficult words that the student clicked on

during the Cold Timing and Practice steps. Click » to view
them.

Read Along The number of times the student is required to read along.
Required

EEL WAL NI RN The number of times the student actually read along.

HECERENELEIM The number of times the student had to practice reading the
story before reading at the goal rate.

Total Practices The total number of times the student practiced reading the
story.

LIS AL EETEIN The student's fastest reading rate, in words per minute, during
Score the Practice step.

CECHRYLTGC NI 18 The number of words in the retell that the student wrote.

GIEIRCITIPACTLICEM The number of questions the student answered correctly the
first time he or she took the quiz.

Hot Timing The number of words correct per minute that the student read
during the Pass timing.
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Changing Story Options for Students

You can change the story options for students while they are working in Student Stories.

Note: Only teachers and the administrator can change story options. Teacher
assistants cannot change story options.

To change the story options from Student Stories:
1 From the Edit menu, choose Story Options.
2 Enter your teacher password, and click OK.
3 Change the student options as necessary.
m  Click the Advanced tab for more options.

m  For detailed descriptions of all of the options, see "Setting Up Story Options for
Students" in Chapter 3.

4 Click Save.
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Printing Stories and Student Results

From Student Stories, you can print the current story and its vocabulary words as well
as all or part of the student's results for the current story.

To print a story and/or a summary of a student's results:

1 From the File menu in Student Stories, choose Print.
2 Enter your teacher password and click OK.

3 Choose the story elements and student results you want to print. You can only print
results from steps students have completed.

Story Check this box to print the picture and text for the current story.
Prediction Check this box to print the prediction that the student wrote.

Check this box to print the quiz questions and student's answers.
Specify whether you want to print the multiple-choice questions,
open-ended questions (typically questions 5, 8, and 9), or both.
You can also specify whether you want the correct answers
marked, the student's answers marked, or no answers marked.

Word List Check this box to print the word list (phonics levels only).

Check this box to print the retell that the student wrote.

Vocabulary Check this box to print the current story's vocabulary words and
their definitions.

Difficult Check this box to print the unknown or difficult words that the
Words student clicked during the Cold Timing and Practice steps.

SIGALRGEIGH Check this box to print the student's results for the current story.

Select All Click this to select all available story elements and student
results.

4 Click Print Preview. The information you selected opens in a separate window.

5 Click Print This Page, or choose Print from the File menu.
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ﬂ Steps for Reading the Stories

This chapter provides in-depth instructions for the steps that students follow when
working with the stories in Read Naturally SE. These are the Read Naturally steps:

1
2

X 3 N W

Select a Story: The student clicks a picture to select a story.

Key Words: The student reads along as the key words are spoken, and then clicks
each word to see and hear its definition.

Prediction: The student uses the title, key words, and picture to write a prediction
of what the story is about.

Cold Timing: The student times him- or herself as he reads the story for the first
time and then views a graph of the results.

Read Along: The student reads along as the story is read to him or her.
Practice: The student practices reading the story on his or her own.
Quiz: The student answers questions about the story.

Retell: The student writes a brief summary in his or her own words of what the
story was about.

Pass: The teacher listens as the student reads the story. The student is timed in order
to verify that the student can read the story at his goal rate. The teacher and student
then view the results together.

The Read Naturally strategy is generally most effective when all of the steps are
included. However, Read Naturally SE allows you to omit steps for individual students
as needed. For example, students who are reading well above their grade level may be
able to skip the Read Along step.

The sequenced levels follow the steps as described in this chapter. The phonics levels
have differences and extra steps that are described in Chapter 6.
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Select a Story Step

Each reading level includes 24 stories in two sets of 12. The set of stories available to
a student is based on the reading level the teacher chose for the student in story options.
The students continue to work on the stories in a level until they pass all the stories in
the level or they are ready for a new level.

If students didn't finish a story the last time they used Student Stories, they must
continue with that story and pass it before selecting a new one. Student Stories marks
the pictures for the stories the student has passed.

® Road Naturally Stories - Level 3.5 - Welcome Janella Stacki
Fle Lt Rotert Hep

Billie Jean Kisg

B
A

_-__ | _Click a picture
to select a story

Jim Tharpe Bs There 3 Bighat?  The Lake That Dissppeared 00 Faithful

L
i3
R

5’
i
;
i
]

To select a story:

1 The students click a picture to select a story from the ones available for their
reading level.

2 The students click Yes to confirm the story selection.
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Key Words Step

This is a vocabulary step that teaches students some key words that are used in the story.
The students learn how to pronounce the words and what they mean.

Fie Lot Retert Heb
m Prediction Cold Timing

?

il

Read Along

Practice

Qui

Ratell

Ready to Pass

Zebras

Key Words
wiinct Click for
narmow g " g
Zoologist definitions

Species

To learn the key words:

1 The students listen and read along as the key words are read for them.

2 The students can then click each of the words to see and hear its definition.

3 The students click Next when they are ready for the next step.

Copyright © 2004—2009 Read Naturally, Inc.
Read Naturally Software Edition

43

SE Teacher's Guide
Steps for Reading the Stories



Prediction Step

In this step, the students use the story title, key vocabulary words, and picture to write a
brief prediction of what they think the story is about. If needed, they can go back to the
Key Words step to review the key words.

This step is important because it teaches the students to prepare to read by thinking
about the topic briefly before beginning to read. This shouldn't take more than a minute
or two, because you want the students to spend most of their time reading.

Teachers can set the time allowed for this step in the students' story options.

® Fohras - Loval 1.5
Fle Lt Rotert Hep

Y | Cold Timing | Read Along | Practice | Quiz | Retell | Ready to Pass

Key Vocabulary Words

anfinct  zoologist
NArTow pecies

Zebras

Wite a prediction about the story.

Zebrars are like horses bul they bave slipes

To write a prediction:

1 The students look at the picture, the key words, and the story title for clues about
what the story is about.

The students can also click Back if they want to review the key words and what
they mean.

2 In the box, the students type a prediction of what they think the story is about.
When typing, the students can use the Backspace, Delete, and arrow keys to move
around and edit text.

3 The students click Next when ready for the next step. If the time allowed for the
prediction step expires, the program automatically advances to the next step.
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Cold Timing Step

In this step, SE times the students for one minute as they read the story for the first
time. This gives you a baseline for measuring the students' improvement. As they
read, students should click words they don't know or have problems with. This

increases a student's awareness of unknown words and alerts you to words or word

patterns you need to teach.

Fle Lt Rotert Hep

KeyWords | Pradiction Read Along | Practice | Quiz | Retell | Ready to Pass

thasves. They had n
1t Sadly, 1o ond will aver

To do the cold timing:

1 If the teacher is required for cold timing, click the lock icon 8 , enter your teacher
password, and click OK.

2 The students can turn the reading guide on or off before they start reading.

3 The students click Start when they are ready to start reading.

If they need to stop and start over, they can click Stop and then click Start when
they are ready to start again.

4 The students read the story quietly and click words they don't know or have
problems with. The words they click change color and are added to the
Difficult Words list.

5 If the students finish the story, they should click the Finished button. If students
click the Finished button early (before they actually finish the story), the program
makes them start over because the words per minute is too high.

6 If students are set up for one- or two-minute timings, a bell sounds when the time
is up. Students should click the last word they read when the bell sounded.

7  After the timing stops, students can click the difficult words they selected
(highlighted in red) to hear them spoken.
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8 The students click Next when they are ready to continue. The Cold Timing Graph
displays.

® Fohras - Loval 1.5

Fle Lt Rotert Hep

KeyWords | Pradiction Read Along | Practice | Quiz | Retell | Ready to Pass

— 100

Goal: 90 — | ———

Janelle Stack, you
read 64 words per — Cold Timing: 64
minute.

—_— 0

The graph shows the number of words the students read correctly in one minute
during the cold timing. SE calculates the number of words read correctly in the
cold timing by subtracting the number of difficult words the students clicked on
from the total number of words read.

A black line marks the student's goal as set up in the story options.
9 The students click Next when they are ready for the next step.
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Read Along Step

In this step, the students read along while listening to a recording of the story, usually
three times. Older students may need to read along only once or twice. Younger or
very disabled students may need to read along four or more times.

In the students' story options, teachers specify the number of read alongs and the
reading speed of each read along. Normally, the first read along is at the slowest
speed, the second read along is 7.5% faster, and the third read along is 15% faster.

This step helps students learn new words and encourages proper pronunciation,
expression, and phrasing. The students should quietly subvocalize as they read
to ensure that they actually read along.

® Zobras - Level 1.5
Fie Lot Retert Heb
e "
Koy Words Prediction Cold Timing | [LETHETRCE ] | Practice Quiz Ratell Ready to Pass

ston

thasves. They had no stripes on thes lage,
adly, 10 O will &vSr $88 3 26bra wih Sis

To read along:
1 The students click the Start button when they are ready to start reading along.

If they need to stop and start over, they can click Stop and then click Start when
they are ready to start again.

2 Each sentence in the story is highlighted as it is read. Students should read aloud
quietly with the recording.

3 After each read along, students can click the vocabulary words (highlighted in blue)
to see and hear their definitions. This helps the students learn the words.

4  After finishing the story, the students click Start to read along again until they have
read the required number of times. A partial read along, where the student stops the
recording and restarts it, does not count. To see how many read alongs the student
has remaining, hold the cursor over the Read Along tab.

5 After completing the required number of read alongs, students can either click Start
to read along again for more practice or click Next to continue with the next step.
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Practice Step

In this step, the students are timed as they practice reading the story without the
recording. They are required to practice until they can read the story at or above
the goal rate their teacher set for them. It may take students six or seven practice
readings to reach their goal.

® Fohras - Loval 1.5
Fie Lok Roten Hep
KeyWords | Prediction | Cold Timing | Read Along Quiz | Retell | Ready to Pass

ston

To practice reading the story:

1

The students can turn the reading guide on or off before they start reading.

The students can also click Back if they want to read along again.

The students click Start when they are ready to start practicing.

If they need to stop and start over, they can click Stop and then click Start when
they are ready to start again.

The students should read the story aloud but quietly. If they finish the story, they
should click the Finished button. If students are set up for whole-story timing, they
must click Finished to stop the timing.

m  If students click the Finished button early (before they actually finish the story),
the program makes them start over because their words per minute is too high.

m  As they read, students can click words they don't know to hear them spoken.
These are counted as difficult words.

If they are set up for one- or two-minute timings, a bell sounds when the time is up.
Students should click the last word they read when the bell sounded.

A box displays the number of words per minute they read. If they did not reach
their goal, they must click Start to practice again. If they do reach their goal, the
Next button is enabled, allowing them to continue with the next step.

Once students reach their goal, they can either click Start to practice again or click
Next to continue by taking the quiz.
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Quiz Step

In this step, the students answer up to nine quiz questions about the story. SE checks
the answers to the multiple-choice questions and repeats them if the students answer
them incorrectly. During the Pass step, the teacher corrects the open-ended questions,
using the answers in the SE Answer Guide for guidance.

® Fohras - Loval 1.5
Fie Lok Roten Hep
KeyWords | Prediction | Cold Timing | Read Along | Practice | [F | Retell | Ready toPass

SCOeE

?
Quiz!

Most people know that 2ebras see wild horges with stripes and tal
thiy vt in Africa. B did you brvow B 3

1. Whan ks the main ldea of this stery?

A I Zebras are wild, striped horses.
B I O kind of 2ebra i row extingl

c Each zebea hae differnt stipes.

e Spacies, Mo S6A500S, and e 4905 O o 2bras

ATourth Speies 0F T00ras BELAMD unct in 1853 bitauss hurtors
Kl 100 sty ofham. Thass 260188 had beautiil Biown and whes
SIripes on thair heads and Tront hades. Thiy had nd stripes on the lage,
e, 18ar halves, O ElE. Sadly, nd Oné will Sver 88 3 J8bra wen Thig
Siripe patiam again

To answer the quiz questions:

1 For sequenced levels 1.0 through 5.0 and phonics levels .8 through 1.8, the story
is on the same screen as the questions. For sequenced levels 5.6 and above and
phonics levels 2.3 and above, students can click Review Story to view the story.
Students can also click the vocabulary words in blue to see and hear definitions.

2 The students answer each of the questions in order. They click Done after
answering the open-ended questions.

3 SE checks the answers to the multiple-choice questions. It re-asks any questions
that the students answered incorrectly until the answers are all correct.

4 The teacher corrects the open-ended questions during the Pass step, using the
answers in the SE Answer Guides for guidance.

Question Formats

The questions for the Read Naturally stories follow a specific format. Understanding
the purpose of the questions helps you identify your students' comprehension problems.
You can use the Comprehension Details Report (see Chapter 7) to track which types of
questions a student answers correctly. A pattern of errors may indicate that a student is
having trouble with a particular area of comprehension or does not know how to answer
a particular type of question. In such cases, you may need to provide more instruction.

The table on the next page describes the question formats for the sequenced series. (See
Chapter 6 for the question formats for the phonics series.)
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The number and types of questions vary by level:

m  Levels 1.0 and 1.5 include only the first five questions; however, due to the
constraints of stories written at the lower reading levels, the questions do not
strictly adhere to the question formats described in the table.

m  Levels 2.0 through 5.0 include only the first five questions.

m  Levels 5.6 through 8.0 include all of the questions.

e L 2 —

Main Idea

2 Literal

3 Vocabulary

4 Inferential
5 Short
Answer

6 Vocabulary

7 Literal

8 Inferential

9 Summary

SE Teacher's Guide
Steps for Reading the Stories

Asks students to identify the main idea of the story (not just
one fact from the story but what the story is mostly about).

Asks students to recall a fact. Students should refer back to
the text for verification.

Asks students to determine the meaning of a vocabulary
word from the context of the story. Sometimes the word has
multiple meanings. Students should use the surrounding
text to help decipher the word's meaning.

Asks students to make connections within the text, putting
together more than one fact from the story to draw a
conclusion. These questions require students to look for
clues in the story.

Asks students to use the information authors provide with
their own ideas. Students should write sentences that stand
on their own.

This question is designed to develop vocabulary. In most
cases, the question includes several words from the story.
The question sometimes asks the student to define words,
sometimes asks for synonyms, and sometimes asks for
antonyms.

Asks students to recall details from the story. The question
sometimes asks the students to put events in sequence.
Other times, the students must fill in the blanks of an excerpt
summary. Some require a few short-answer responses.

Usually asks students to connect more than one fact from
the story to draw a conclusion. Occasionally asks students
to differentiate between factual statements and opinions.

Asks students to work on their summarizing skills. The
question sometimes asks the student to support a particular
statement. Other times it asks them to write a summary
statement for the information provided in the question.
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Retell Step

In this step, the students retell information from the story. In the students' story
options, you can specify the number of minutes allowed for the Retell step. You could
also disable this step in story options and have students tell you their retell orally instead
of typing it on the computer.

Note: Students using the phonics levels do not complete this step. Instead, they
practice reading word lists after passing the story. For more information, see
Chapter 6.

® Zobras - Level 1.5
Fie Lot Retert Heb
Koy Words Prediction Cold Timing Read Along Practice CQuiz | BENI | Ready to Pass

SCOeE

Zebras

Zebeas are wild horses with sinipes. Different kinds of
zebras have diferent kinds of stripes |

Ratell the story in your own words.

To type a retell:

1 If students want to review the story again before they type their retell, they can click
the Review Story button under the picture. Students can only review the story
once.

2 The stude